ACKNOWLEDGMENTS

Producing effective learning materials for such an advanced technology is a team effort. Friends, colleagues, fellow filmmakers, and technology experts have all contributed to this book. There are too many names to mention, but let's say this: I have often joked that in Britain we don't say “awesome.” Instead, we say “perfectly acceptable.” On this occasion, “perfectly acceptable” simply isn't enough. Instead, I will have to say our British equivalent of “super awesome”: those people who make this world better by sharing, nurturing, caring, showing, telling, demonstrating, making, and helping are all “more than acceptable.”

Everything on these pages was inspected by a team of experienced editors who checked and corrected typos, spelling errors, naming errors, false attributions, suspect grammar, unhelpful phrasing, and inconsistent descriptions. This wonderful team didn't just highlight text that needed correcting. They offered positive alternatives that I could simply agree to, so in a literal sense, this book is the product of many people's contributions. I'd like to thank the whole team at Peachpit and Adobe Press, who made it possible to produce such a beautifully finessed work.

As each draft chapter was completed, the most excellent Conrad Chavez checked all references to technology and highlighted errors, opportunities to clarify, and potential details to expand upon. Conrad's comments are beautifully clear and simple, with great accuracy. Having worked previously with Conrad, who is also a technical author, I knew his knowledge and awareness of the reader's journey would be incredibly helpful.

A substantial amount of the content of this book is derived from material written by Richard Harrington three versions back. The current table of contents was originally worked out by the two of us, and though I have updated his chapters, rephrased, and reworded them, a substantial amount remains unchanged or is significantly informed by his original work.

Finally, let's not forget Adobe. The passion and enthusiasm demonstrated by those wonderful individuals, who are so committed to creatives like you and me, qualifies as “the most acceptable of all.” They are, indeed, extraordinarily awesome!
CONTENTS

GETTING STARTED xvii

About Classroom in a Book ................................ xvi
Prerequisites .............................................. xviii
Installing Premiere Pro CC ................................ xviii
Optimizing performance .................................. xviii
Using the lesson files ....................................... xix
Relinking the lesson files ................................... xx
How to use these lessons ................................. xx
Online content ............................................ xxi
Lesson files .................................................. xxi
Accessing the Web Edition .................................. xxi
Additional resources ...................................... xxii
Adobe Authorized Training Centers .................. xxiii

1 TOURING ADOBE PREMIERE PRO CC 2

Getting started ............................................. 4
Performing nonlinear editing in Premiere Pro ........ 4
Looking at the standard digital video workflow .......... 5
Enhancing the workflow with Premiere Pro ............. 6
Expanding the workflow .................................... 8
Incorporating other components into the editing workflow ........ 8
Looking at the Adobe Creative Cloud video workflow .... 9
Touring the Premiere Pro workspace .................... 10
Looking at the workspace layout ....................... 11
Customizing the workspace .............................. 14
Introducing preferences .................................. 16
Keyboard shortcuts ....................................... 18
Moving, backing up, and syncing user settings ....... 19
Review Questions .......................................... 20
Review Answers ........................................... 21
2 SETTING UP A PROJECT

Getting started .......................................................... 24
Setting up a project .................................................. 25
Exploring video rendering and playback settings .......... 26
Setting the video and audio display formats ................. 28
Setting the capture format ........................................ 31
Displaying the project item names and label colors ......... 31
Setting up the scratch disks ....................................... 32
Setting up Project Auto Save location ......................... 32
CC Libraries downloads .......................................... 33
Choosing ingest settings .......................................... 34
Importing projects from Final Cut Pro ......................... 36
Importing Avid Media Composer projects .................... 37
Setting up a sequence ............................................. 38
Creating a sequence that automatically matches your source 39
Choosing the correct preset ..................................... 39
Customizing a sequence preset ................................ 42
Understanding track types ..................................... 43
Understanding submixes ....................................... 45
Review Questions .................................................. 46
Review Answers .................................................... 47

3 IMPORTING MEDIA

Getting started .......................................................... 50
Importing assets ....................................................... 50
When to use the Import command .............................. 50
When to use the Media Browser ................................ 51
Working with ingest options and proxy media .............. 52
Working with the Media Browser ............................... 55
Following a file-based camera workflow .................... 55
Understanding supported video file types ................... 56
Finding assets with the Media Browser ....................... 56
Importing images .................................................... 59
Importing flattened Adobe Photoshop files .................. 60
Importing layered Adobe Photoshop files .................... 60
Importing Adobe Illustrator files ................................ 62
Importing subfolders ............................................. 63
Using Adobe Stock ................................................. 63
4 ORGANIZING MEDIA

Getting started .......................................................... 70
Using the Project panel .............................................. 70
Customizing the Project panel ...................................... 71
Finding assets in the Project panel ................................ 73
Working with bins ..................................................... 75
Creating bins ............................................................ 76
Managing media in bins .............................................. 77
Changing bin views .................................................... 78
Assigning labels ......................................................... 80
Changing names ......................................................... 81
Customizing bins ....................................................... 81
Having multiple bins open at once ............................... 83
Monitoring footage .................................................... 83
Lowering the playback resolution ................................ 85
Getting timecode information ................................ ...... 86
Using essential playback controls ................................ 87
Customizing the monitors .......................................... 88
Modifying clips .......................................................... 89
Adjusting audio channels .......................................... 89
Merging clips ............................................................. 90
Interpreting video footage ........................................... 91
Working with raw files .............................................. 92
Review Questions ..................................................... 94
Review Answers ....................................................... 95

5 MASTERING THE ESSENTIALS OF VIDEO EDITING

Getting started .......................................................... 98
Using the Source Monitor .......................................... 98
Loading a clip ............................................................ 99
Loading multiple clips .............................................. 100
Using Source Monitor controls .................................. 101
Selecting a range in a clip .......................................... 101
Creating subclips ...................................................... 104
Navigating the Timeline ................................... 105
What is a sequence? ........................................ 107
Opening a sequence in the Timeline panel ............ 107
Understanding tracks ...................................... 108
Targeting tracks ............................................ 109
Using In and Out marks ................................... 110
Using time rulers ......................................... 112
Customizing track headers ................................ 112
Using essential editing commands ...................... 113
Overwrite edit .............................................. 113
Insert edit .................................................. 114
Three-point editing ........................................ 116
Storyboard editing ......................................... 117
Review Questions .......................................... 121
Review Answers ........................................... 121

6 WORKING WITH CLIPS AND MARKERS 122
Getting started ........................................... 124
Using Program Monitor controls ....................... 124
What is the Program Monitor? ........................... 124
Adding clips to the Timeline with the Program Monitor .... 126
Setting the playback resolution ....................... 129
Changing playback resolution ........................ 130
Changing resolution when playback is paused ....... 131
Playing back VR video .................................... 132
Using markers ............................................ 133
What are markers? ....................................... 133
Exploring the types of markers ....................... 134
Automating the editing to markers ................... 137
Finding clips in the Timeline ............................ 139
Using Sync Lock and Track Lock ....................... 140
Using sync locks ......................................... 140
Using track locks ....................................... 141
Finding gaps in the Timeline ............................ 141
Selecting clips ............................................ 142
Selecting a clip or range of clips ...................... 142
Selecting all the clips on a track .................... 143
Selecting audio or video only ......................... 143
Splitting a clip ........................................... 144
Linking and unlinking clips .................................................. 144
Moving clips ................................................................. 145
Dragging clips ............................................................... 145
Nudging clips ................................................................. 146
Rearranging clips in a sequence ........................................ 147
Using the clipboard ......................................................... 148
Extracting and deleting segments ........................................ 148
Performing a lift edit ......................................................... 148
Performing an extract edit .................................................. 149
Performing a delete and ripple delete edit ............................ 149
Disabling a clip ............................................................... 150
Review Questions ........................................................... 151
Review Answers ............................................................. 151

7  ADDING TRANSITIONS ................................................. 152
Getting started ............................................................... 154
What are transitions? ....................................................... 155
Knowing when to use transitions ...................................... 155
Implementing best practices with transitions ...................... 156
Using edit points and handles .......................................... 156
Adding video transitions .................................................. 157
Applying a single-sided transition ..................................... 158
Applying a transition between two clips ............................ 159
Applying transitions to multiple clips at once ...................... 161
Using A/B mode to fine-tune a transition ............................ 163
Changing parameters in the Effect Controls panel ............... 163
Using a Morph Cut effect .................................................. 165
Dealing with inadequate (or nonexistent) head or tail handles 166
Adding audio transitions .................................................. 168
Creating a crossfade ......................................................... 168
Applying audio transitions ................................................. 169
Review Questions ........................................................... 171
Review Answers ............................................................. 171

8  PERFORMING ADVANCED EDITING TECHNIQUES ......................... 172
Getting started ............................................................... 174
Performing four-point editing .......................................... 174
Editing options for four-point edits .................................... 174
Making a four-point edit .................................................... 175
Changing playback speed...........................................176
Changing the speed/duration of a clip ........................178
Changing the speed/duration with the Rate Stretch tool ....180
Changing the speed/duration with time remapping..........180
Replacing clips and footage .....................................183
Dragging in a replacement clip ................................183
Making a replace edit ............................................184
Using the Replace Footage feature .............................185
Nesting sequences ................................................186
Adding a nested sequence .....................................187
Performing regular trimming ....................................188
Trimming in the Source Monitor ..............................188
Trimming in a sequence ......................................188
Performing advanced trimming ................................189
Making ripple edits ..............................................189
Making rolling edits ............................................191
Making sliding edits ............................................191
Making slip edits ................................................192
Trimming in the Program Monitor ............................193
Using Trim mode in the Program Monitor ..................194
Choosing a trimming method in the Program Monitor ....195
Performing dynamic trimming ................................197
Trimming with the keyboard ................................198
Review Questions ................................................199
Review Answers ................................................199

9 PUTTING CLIPS IN MOTION ........................................200
Getting started ...................................................202
Adjusting the Motion effect ....................................202
Understanding Motion settings ...............................203
Examining Motion properties ................................205
Changing clip position, size, and rotation .................207
Changing position ..............................................207
Reusing Motion settings ......................................209
Adding rotation and changing the anchor point ..........210
Changing clip size ..............................................211
Animating clip size changes ................................214
<table>
<thead>
<tr>
<th>Working with keyframe interpolation</th>
<th>216</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using different keyframe interpolation methods</td>
<td>216</td>
</tr>
<tr>
<td>Adding Ease to Motion</td>
<td>218</td>
</tr>
<tr>
<td>Using other motion-related effects</td>
<td>219</td>
</tr>
<tr>
<td>Adding a drop shadow</td>
<td>219</td>
</tr>
<tr>
<td>Adding a bevel</td>
<td>220</td>
</tr>
<tr>
<td>Adding motion with the Transform effect</td>
<td>222</td>
</tr>
<tr>
<td>Manipulating clips in 3D space with Basic 3D</td>
<td>224</td>
</tr>
<tr>
<td>Review Questions</td>
<td>226</td>
</tr>
<tr>
<td>Review Answers</td>
<td>227</td>
</tr>
</tbody>
</table>

10 **MULTICAMERA EDITING**

<table>
<thead>
<tr>
<th>Getting started</th>
<th>230</th>
</tr>
</thead>
<tbody>
<tr>
<td>Following the multicamera process</td>
<td>230</td>
</tr>
<tr>
<td>Creating a multicamera sequence</td>
<td>231</td>
</tr>
<tr>
<td>Determining the sync points</td>
<td>231</td>
</tr>
<tr>
<td>Adding clips to a multicamera source sequence</td>
<td>232</td>
</tr>
<tr>
<td>Creating the multicamera target sequence</td>
<td>234</td>
</tr>
<tr>
<td>Switching multiple cameras</td>
<td>235</td>
</tr>
<tr>
<td>Performing a multicamera edit</td>
<td>235</td>
</tr>
<tr>
<td>Re-recording multicamera edits</td>
<td>237</td>
</tr>
<tr>
<td>Finalizing multicamera editing</td>
<td>238</td>
</tr>
<tr>
<td>Switching an angle</td>
<td>238</td>
</tr>
<tr>
<td>Flattening a multicamera edit</td>
<td>238</td>
</tr>
<tr>
<td>Review Questions</td>
<td>239</td>
</tr>
<tr>
<td>Review Answers</td>
<td>239</td>
</tr>
</tbody>
</table>

11 **EDITING AND MIXING AUDIO**

<table>
<thead>
<tr>
<th>Getting started</th>
<th>242</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting up the interface to work with audio</td>
<td>242</td>
</tr>
<tr>
<td>Working in the Audio workspace</td>
<td>243</td>
</tr>
<tr>
<td>Defining master track output</td>
<td>245</td>
</tr>
<tr>
<td>Using the audio meters</td>
<td>246</td>
</tr>
<tr>
<td>Viewing samples</td>
<td>246</td>
</tr>
<tr>
<td>Showing audio waveforms</td>
<td>248</td>
</tr>
<tr>
<td>Working with standard audio tracks</td>
<td>249</td>
</tr>
<tr>
<td>Monitoring audio</td>
<td>250</td>
</tr>
<tr>
<td>Examining audio characteristics</td>
<td>250</td>
</tr>
</tbody>
</table>
Creating a voice-over “scratch track” ............................ 252
Adjusting audio volume .......................................................... 253
Adjusting audio in the Effect Controls panel .................. 253
Adjusting audio gain ................................................................. 255
Normalizing audio ................................................................. 255
Creating a split edit ................................................................. 257
Adding a J-cut ................................................................. 258
Adding an L-cut ................................................................. 258
Adjusting audio levels for a clip ........................................... 258
Adjusting overall clip levels ................................................. 259
Keyframing volume changes ................................................. 260
Smoothing volume between keyframes ................................ 260
Using clip vs. track keyframes ............................................. 261
Working with the Audio Clip Mixer ...................................... 261
Review Questions ................................................................. 263
Review Answers ................................................................. 263

12 SWEETENING SOUND ............................................. 264
Getting started ................................................................. 266
Sweetening sound with audio effects .................................. 266
Adjusting bass ................................................................. 267
Adding a delay ................................................................. 268
Adjusting pitch ................................................................. 269
Adjusting treble ................................................................. 270
Adding reverb ................................................................. 270
Adjusting EQ ................................................................. 271
Simple Parametric EQ .......................................................... 272
Parametric EQ ................................................................. 272
Cleaning up noisy audio ..................................................... 275
Highpass and Lowpass effects ............................................ 275
MultiBandCompressor effect ............................................ 276
Notch effect ................................................................. 279
Loudness Radar effect .......................................................... 282
Review Questions ................................................................. 285
Review Answers ................................................................. 285

© 2017 Adobe Systems Incorporated and its licensors. All rights reserved. For instructor use only.
13  ADDING VIDEO EFFECTS  286

Getting started ........................................... 288
Working with effects ........................................ 288
Fixed effects ................................................ 288
The Effects panel ........................................... 290
Applying effects ........................................... 292
Using adjustment layers .................................... 294
Sending a clip to Adobe After Effects .................... 296
Master clip effects ........................................... 299
Masking and tracking visual effects ......................... 301
Keyframing effects .......................................... 304
Adding keyframes ......................................... 305
Adding keyframe interpolation and velocity .............. 306
Effect presets ............................................... 308
Using built-in presets ....................................... 309
Saving effect presets ....................................... 310
Frequently used effects .................................... 312
Image stabilization and rolling shutter reduction .......... 312
Timecode and Clip Name .................................... 313
Shadow/Highlight .......................................... 315
Lens distortion removal ..................................... 317
Render all sequences ....................................... 317
Render and replace ......................................... 317
Review Questions .......................................... 319
Review Answers ........................................... 319

14  IMPROVING CLIPS WITH COLOR CORRECTION AND GRADING  320

Getting started ........................................... 322
Following a color-oriented workflow ....................... 323
The Color workspace ....................................... 324
The Lumetri Color panel ..................................... 325
Lumetri Scopes essentials .................................. 328
The Lumetri Scopes panel .................................. 330
An overview of color-oriented effects ..................... 337
Coloring effects ............................................. 338
Color removal or replacement .............................. 339
Color correction ............................................. 339
Video Limiter ............................................... 340
Fixing exposure problems ........................................ 341
Underexposed images ........................................ 342
Overexposed images ........................................ 343
Fixing color balance ............................................ 344
Basic white balance (Fast Color Corrector) ............... 345
Primary color correction ..................................... 346
Balancing Lumetri color wheels ............................. 348
Using special color effects ................................... 350
Gaussian Blur ................................................... 350
Stylize ........................................................... 350
Lumetri looks ................................................... 350
Creating a look .................................................. 351
Review Questions .............................................. 353
Review Answers ............................................... 353

15 EXPLORING COMPOSITING TECHNIQUES 354
Getting started .................................................. 356
What is an alpha channel? ................................... 357
Making compositing part of your projects .................. 358
Shooting videos with compositing in mind ................. 358
Essential terminology ........................................ 359
Working with the Opacity effect ............................ 360
Keyframing opacity .......................................... 361
Combining tracks based on a blend mode ................. 362
Working with alpha-channel transparencies .............. 363
Color keying a greenscreen shot ............................ 364
Preprocessing the footage ................................... 365
Using the Ultra Key effect .................................. 366
Masking clips ................................................... 369
Using mattes that use graphics or other clips ............. 370
Review Questions .............................................. 372
Review Answers ............................................... 373

16 CREATING TITLES 374
Getting started .................................................. 376
An overview of the Titler window ......................... 376
Mastering video typography essentials ................. 380
Font choice ..................................................... 380
17 MANAGING YOUR PROJECTS

Getting started ........................................... 404
Using the File menu ....................................... 404
Using the File menu commands ....................... 405
Making a clip offline ..................................... 405
Using the Project Manager ................................. 406
Collecting files and copying them to a new location . 408
Consolidating and transcoding ............................ 409
Rendering and replacing .................................. 411
Using the Link Media panel and the Locate command . 412
Performing the final project management steps ........... 414
Importing projects or sequences ....................... 414
Managing collaboration .................................... 416
Using the Libraries panel ................................. 417
Managing your hard drives ................................................. 417
Additional files .................................................................. 417
Review Questions .................................................................. 419
Review Answers .................................................................. 419

18 EXPORTING FRAMES, CLIPS, AND SEQUENCES ........ 420
Getting started ................................................................. 422
Overview of export options ................................................ 422
Exporting single frames ...................................................... 423
Exporting a master copy ...................................................... 424
Matching sequence settings ................................................. 424
Choosing another codec ..................................................... 426
Working with Adobe Media Encoder .................................... 427
Choosing a file format for export ......................................... 427
Configuring the export ......................................................... 430
Using the Source and Output panels .................................... 432
Queuing the export ............................................................. 432
Additional options in Adobe Media Encoder ......................... 434
Uploading to social media ................................................... 435
Exchanging with other editing applications ......................... 436
Exporting a Final Cut Pro XML file ....................................... 436
Exporting to OMF .............................................................. 436
Exporting to AAF .............................................................. 437
Final practice ................................................................. 438
Review Questions .............................................................. 440
Review Answers .............................................................. 441

INDEX ............................................................................. 442

© 2017 Adobe Systems Incorporated and its licensors. All rights reserved. For instructor use only.
GETTING STARTED

Adobe Premiere Pro CC, the essential editing tool for video enthusiasts and professionals, is the most scalable, efficient, and precise video-editing tool available. It supports a broad range of video formats, including AVCHD, HDV, Sony XDCAM EX, HD and HD422, Sony RAW, Panasonic P2 DVCPRO HD, AVC-Intra, Canon XF and Canon RAW, RED R3D, ARRIRAW, Digital SLR, Blackmagic CinemaDNG, Avid DNxHD and DNxHR, QuickTime and AVI files, GoPro Cineform, and many more. Premiere Pro lets you work faster and more creatively without converting your media. The complete set of powerful and exclusive tools lets you overcome any editorial, production, and workflow challenges to deliver the high-quality work you demand.

Importantly, Adobe has created a user experience that is intuitive, flexible, and efficient, with unified design elements that match across multiple applications, making it easier to explore and discover new workflows.

About Classroom in a Book

*Adobe Premiere Pro CC Classroom in a Book (2017 release)* is part of the official training series for Adobe graphics and publishing and creative video software. The lessons are designed so that you can learn at your own pace. If you’re new to Premiere Pro, you’ll learn the fundamental concepts and features you’ll need to use the program. This book also teaches many advanced features, including tips and techniques for using the latest version of this software.

The lessons in this edition include opportunities for hands-on practice using features such as chromakeying, dynamic trimming, color correction, tapeless media, audio and video effects, and advanced integration with Photoshop, After Effects, and Audition. You’ll also learn how to create files for the web and mobile devices with Media Encoder. Premiere Pro CC is available for both Windows and Mac OS.
**Prerequisites**

Before beginning to use *Adobe Premiere Pro CC Classroom in a Book*, make sure your system is set up correctly and that you’ve installed the required software and hardware. You can view updated system requirements here:

helpx.adobe.com/premiere-pro/system-requirements.html

You should have a working knowledge of your computer and operating system. You should know how to use the mouse and standard menus and commands and also how to open, save, and close files. If you need to review these techniques, see the documentation included with your Windows or Mac OS system.

**Installing Premiere Pro CC**

You must purchase an Adobe Creative Cloud subscription or obtain a trial version, separately from this book. For system requirements and complete instructions on installing the software, visit www.adobe.com/support. You can purchase Adobe Creative Cloud by visiting www.adobe.com/products/creativecloud. Follow the onscreen instructions. You may also want to install Photoshop, After Effects, Audition, Prelude, and Media Encoder, which are included with the full Adobe Creative Cloud license.

**Optimizing performance**

Editing video places high demands on your computer processor and memory. A fast processor and a lot of memory will make your editing experience faster and more efficient. This translates to a more fluid and enjoyable creative experience.

Premiere Pro takes advantage of multicore processors (CPUs) and multiprocessor systems. The faster the processors, and the more there are, the better the performance you’ll experience.

The minimum system memory is 8 GB, and 16 GB or more is recommended for ultra-high-definition (UHD) media.

The speed of the storage drives you use for video playback is also a factor. A dedicated fast storage drive is recommended for your media. A RAID disk array or fast solid-state disk is strongly recommended, particularly if you’re working with 4K or higher-resolution media. Storing your media files and program files on the same hard drive can affect performance. Keep your media files on a separate disk if possible.

The Premiere Pro Mercury Playback Engine can utilize the power of your GPU, harnessing the power of your computer’s graphics hardware to improve playback.
performance. GPU acceleration provides a significant performance improvement, and most video cards with at least 1 GB of dedicated memory will work. You will find information about hardware and software requirements on the Adobe website at http://helpx.adobe.com/premiere-pro/system-requirements.html.

Using the lesson files

The lessons in this book use supplied source files, including video clips, audio files, and image files created in Photoshop and Illustrator. To complete the lessons in this book, you must copy all the lesson files to your computer’s storage drive. Some lessons use files from other lessons, so you’ll need to keep the entire collection of lesson assets on your storage drive as you work through the book. You will need about 8 GB of storage space in addition to the space needed to install Premiere Pro.

If you have purchased an ebook edition of this book, you’ll need to download the lesson files from peachpit.com. You’ll find instructions for doing so, before the table of contents, in the section “Where are the Lesson Files?”

If you’ve purchased the printed version, you can copy the lesson files from the Adobe Premiere Pro CC Classroom in a Book disc (inside the back cover of this book).

Here’s how to copy those assets from the disc to your storage drive:

1. Open the Adobe Premiere Pro CC Classroom in a Book disc in My Computer or Windows Explorer (Windows) or in Finder (Mac OS).

2. Right-click the folder called Lessons and choose Copy.

3. Navigate to the location you have chosen to store your Premiere Pro projects, right-click, and choose Paste.

If you do not have a disc drive on your computer, see the “Online Content” section for more information about downloading the lesson files.

Tip: If you don’t have dedicated storage for your video files, placing the lesson files on your computer’s desktop will make them easy to find and work with.
Relinking the lesson files

The Premiere Pro projects included with the lesson files have links to specific media files. Because you are copying the files to a new location, those links may need to update when you open projects for the first time.

If you open a project and Premiere Pro is unable to find a linked media file, the Link Media dialog may open, inviting you to relink offline files. If this happens, select an offline clip and click the Locate button and a browse panel will appear to locate it.

Locate the Lessons folder using the navigator on the left, and click Search. Premiere Pro will locate the media file inside the Lessons folder. To hide all other files, making it easy to select the right one, select the option to display only exact name matches.

The last known file path and file name and the currently selected file path and file name are displayed at the top of the panel for reference. Select the file and click OK.

The option to relink other files is enabled by default, so once you've located one file, the rest should reconnect automatically. For more information about relocating offline media files, see Chapter 17, “Managing Your Projects.”

How to use these lessons

The lessons in this book provide step-by-step instructions. Each lesson stands alone, but most build on previous lessons. For this reason, the best way to learn from this book is to proceed through the lessons one after another.

The lessons teach you new skills in the order you might use them while performing post-production for a real project. Rather than being feature-oriented, this book uses a real-world approach. The lessons begin with acquiring media files such as video, audio, and graphics, and go on to creating a rough cut sequence, adding effects, sweetening the audio, and ultimately exporting the project.

By the end of these lessons, you'll have a good understanding of the complete end-to-end post-production workflow, with the specific skills you need to edit on your own.

Note: If media files were originally stored in multiple locations, you may need to search more than once to relink all the media for a project.
Online content

Lesson files

To work through the projects in this book, you will need to copy them from the disc (see “Using the lesson files”) or download the lesson files from peachpit.com. You can download the files for individual lessons or it may be possible to download them all in a single file.

This book comes with a free Web Edition that can be accessed from any device with a connection to the Internet. Its benefits include the following:

• The complete text of the book
• Hours of instructional video keyed to the text
• Interactive quizzes

In addition, the Web Edition may be updated when Adobe adds significant feature updates between major Creative Cloud releases. To accommodate the changes, sections of the online book will be updated or new sections will be added.

Accessing the Web Edition

Your purchase of this Classroom in a Book in any format includes access to the corresponding Web Edition.

If you purchased an ebook from peachpit.com or adobepress.com, your Web Edition will automatically appear under the Digital Purchases tab on your Account page. Click the Launch link to access the product. Continue reading to learn how to register your product to get access to the lesson files.

If you purchased an eBook from a different vendor or you bought a print book, you must register your purchase on peachpit.com in order to access the online content:

1 Go to www.peachpit.com/register.
2 Sign in or create a new account.
4 Answer the questions as proof of purchase.
5 The Web Edition will appear on the Digital Purchases tab of your Account page. Click the Launch link to access the product.

The Lesson Files can be accessed through the Registered Products tab on your Account page. Click the Access Bonus Content link below the title of your product to proceed to the download page. Click the lesson file links to download them to your computer.
Additional resources

Adobe Premiere Pro CC Classroom in a Book (2017 release) is not meant to replace documentation that comes with the program or to be a comprehensive reference for every feature. Only the commands and options used in the lessons are explained in this book. For comprehensive information about program features and tutorials, refer to these resources:


Adobe Forums: forums.adobe.com lets you tap into peer-to-peer discussions, questions, and answers on Adobe products.

Adobe Premiere Pro CC product home page: adobe.com/products/premiere has more information about the product.

Adobe Add-ons: creative.adobe.com/addons is a central resource for finding tools, services, extensions, code samples, and more to supplement and extend your Adobe products.

Resources for educators: adobe.com/education and edex.adobe.com offer a treasure trove of information for instructors who teach classes on Adobe software. You’ll find solutions for education at all levels, including free curricula that use an integrated approach to teaching Adobe software and can be used to prepare for the Adobe Certified Associate exams.
Adobe Authorized Training Centers
Adobe Authorized Training Centers offer instructor-led courses and training on Adobe products, employing only Adobe Certified Instructors. A directory of AATCs is available at training.adobe.com/trainingpartners.
This page intentionally left blank
Lesson overview

In this lesson, you’ll learn about the following:

- Using the Project panel
- Staying organized with bins
- Adding clip metadata
- Using essential playback controls
- Interpreting footage
- Making changes to your clips

This lesson will take approximately 90 minutes.
Once you have some video and sound assets in your project, you’ll begin looking through your footage and adding clips to a sequence. Before you do, it’s well worth spending a little time organizing the assets you have. Doing so can save you from spending hours hunting for things later.
Getting started

When you have lots of clips in your project, imported from several different media types, it can be a challenge to stay on top of everything and always find that magic shot when you need it.

In this lesson, you’ll learn how to organize your clips using the Project panel, which is the heart of your project. You’ll create special folders, called bins, to divide your clips into categories. You’ll also learn about adding important metadata and labels to your clips.

You’ll begin by getting to know the Project panel and organizing your clips.

1. To begin, reset the workspace to the default. In the Workspace panel, click Editing. Then click the menu adjacent to the Editing option and choose Reset to Saved Layout.

2. For this lesson, you’ll use the project file you used in Lesson 3, “Importing Media.” Continue to work with the project file from the previous lesson, or open it from your hard drive.

3. Choose File > Save As.

4. Rename the file Lesson 04.prproj.

5. Browse to the Lessons folder, and click Save to save the project.

If you do not have the previous lesson file, you can open the file Lesson 04.prproj from the Lessons/Lesson 04 folder.

Using the Project panel

Everything you import into your Adobe Premiere Pro CC project will appear in the Project panel. As well as giving you excellent tools for browsing your clips and working with their metadata, the Project panel has folder-like “bins” that you can use to stay organized.

Anything that appears in a sequence must also be in the Project panel. If you delete a clip in the Project panel that is already used in a sequence, the clip will automatically be removed from the sequence. Premiere Pro will warn you if deleting a clip will affect an existing sequence.

As well as acting as the repository for all your clips, the Project panel gives you important options for interpreting media. All your footage will have a frame rate (frames per second, or fps) and a pixel aspect ratio (pixel shape), for example. You may want to change these settings for creative reasons.
You could, for example, interpret video recorded at 60fps video as 30fps to achieve a 50 percent slow-motion effect. You might occasionally receive a video file that has the wrong pixel aspect ratio setting and want to correct it.

Premiere Pro uses metadata associated with footage to know how to play it back. If you want to change the clip metadata, you can do so in the Project panel.

**Customizing the Project panel**

It's likely that you'll want to resize the Project panel from time to time. You'll alternate between looking at your clips as a list or as thumbnail icons. Sometimes it's quicker to resize the panel than to scroll to see more information.

The default Editing workspace is designed to keep the interface as clean as possible so you can focus on your creative work. Part of the Project panel that's hidden
from view by default, called the Preview Area, gives additional information about your clips.

Let’s take a look:

1. Click the panel menu for the Project panel (on the panel tab).
2. Choose Preview Area.

The Preview Area displays useful information for clips you select.

The Preview Area shows you several kinds of useful information about a selected clip in the Project panel, including the frame size, pixel aspect ratio, and duration.

If it’s not already selected, click the List View button ( ) at the bottom left of the Project panel. In this view, you’ll find a lot of information about each clip in the Project panel, but you need to scroll horizontally to see it.

3. Click the panel menu for the Project panel (on the Panel tab).
4. Choose Preview Area to hide it.
Finding assets in the Project panel

Working with clips is a little like working with pieces of paper at your desk. If you have just one or two clips, it’s easy. But when you have 100 to 200, you need a system.

One way you can help make things smoother during the edit is to invest a little time in organizing your clips at the beginning. If you rename your clips after importing them, it will make it easier for you to locate content later (see “Changing names” in this chapter).

1 Click the Name heading at the top of the Project panel. The items in the Project panel are displayed in alphabetical order or reverse alphabetical order each time you click the Name heading again.

If you’re searching for several clips with particular features—such as a duration or a frame size—it can be helpful to change the order in which the headings are displayed.

2 Scroll to the right until you can see the Media Duration heading in the Project panel. This shows the total duration of each clip’s media file.

3 Click the Media Duration heading. Premiere Pro now displays the clips in order of media duration. Notice the direction arrow on the Media Duration heading. Each time you click the heading, the direction arrow toggles between showing clips in duration order and in reverse duration order.

4 Drag the Media Duration heading to the left until you see a blue divider between the Frame Rate heading and the Name heading. When you release the mouse button, the Media Duration heading will be repositioned right next to the Name heading.

Filtering bin content

Premiere Pro has built-in search tools to help you find your media. Even if you’re using nondescriptive original clip names assigned in-camera, you can search for clips based on a number of factors, such as frame size or file type.

Note: Graphic and photo files such as Photoshop PSD, JPEG, and Illustrator AI files import with a default frame duration you set after choosing Preferences > General > Still Image Default Duration.
At the top of the Project panel, you can type in the Filter Bin Content box to display only clips with names or metadata matching the text you enter. This is a quick way to locate a clip if you remember its name (or even part of its name). Clips that don’t match the text you enter are hidden, and clips that do match are revealed, even if they are inside a closed bin.

Try this now:

1. Click in the Filter Bin Content box, and type jo.

Premiere Pro displays only the clips with the letters jo in the name or in the metadata. Notice that the name of the project is displayed above the text entry box, along with “(filtered).”

2. Click the X on the right of the Find box to clear your search.

3. Type psd in the box.

Premiere Pro displays only clips that have the letters psd in their name or metadata. In this case, it’s the Theft_Unexpected title you imported earlier as a layered image—this is a Photoshop PSD file. Using the Filter Bin Content box in this way, you can search for particular types of files.

Be sure to click the X on the right of the Filter Bin Content box to clear your filter when you have found the clips you want.

**Using advanced Find**

Premiere Pro also has an advanced Find option. To learn about it, you can import a couple more clips.

Using any of the methods described in Lesson 3, import these items:

- Seattle_Skyline.mov from the Assets/Video and Audio Files/General Views folder
- Under Basket.MOV from the Assets/Video and Audio Files/Basketball folder
At the bottom of the Project panel, click the Find button (🔍). Premiere Pro displays the Find panel, which has more advanced options for locating your clip.

You can perform two searches at once with the advanced Find panel. You can choose to display clips that match all search criteria or any search criteria. For example, depending on the setting you choose in the Match menu, you could do either of the following:

- Search for a clip with the words *dog AND boat* in its name.
- Search for a clip with the word *dog OR boat* in its name.

To do this, make selections from the following menus:

- **Column:** This option lets you select from the available headings in the Project panel. When you click Find, Premiere Pro will search using only the heading you select.
- **Operator:** This option gives you a set of standard search options. Use this menu to choose whether you want to find a clip that contains, matches exactly, begins with, or ends with whatever you search for.
- **Match:** Choose All to find a clip with both your first and your second search text. Choose Any to find a clip with either your first or your second search text.
- **Case Sensitive:** Selecting this option tells Premiere Pro whether you want your search to exactly match the uppercase and lowercase letters you enter.
- **Find What:** Type your search text here. You can add up to two sets of search text.

When you click Find, Premiere Pro highlights a clip that matches your search criteria. Click Find again, and Premiere Pro highlights the next clip that matches your search criteria. Click Done to exit the Find dialog box.

### Working with bins

Bins allow you to organize clips by dividing them into groups.

Just like folders on your hard drive, you can have multiple bins inside other bins, creating a folder structure as complex as your project requires.
There’s an important difference between bins and the folders on your storage drive: Bins exist only in your Premiere Pro project file to help organize clips. You won’t find individual folders representing project bins on your storage drive.

**Creating bins**

Let’s create a bin.

1. Click the New Bin button ( ) at the bottom of the Project panel.
   Premiere Pro creates a new bin and automatically highlights the name, ready for you to rename it. It’s a good habit to name bins as soon as you create them.

2. You have already imported some clips from a film, so let’s give them a bin. Name the new bin *Theft Unexpected*.

3. You can also create a bin using the File menu. Let’s do this now: Make sure the Project panel is active, and choose File > New > Bin.

4. Name the new bin *Graphics*.

5. You can also make a new bin by right-clicking a blank area in the Project panel and choosing New Bin. Try this now.

6. Name the new bin *Illustrator Files*.

   One of the quickest and easiest ways to create a new bin for clips you already have in your project is to drag and drop the clips onto the New Bin button at the bottom of the Project panel.

7. Drag and drop the clip *Seattle_Skyline.mov* onto the New Bin button.

8. Name the newly created bin *City Views*.

9. Make sure the Project panel is active but no existing bins are selected. Press the keyboard shortcut Control+B (Windows) or Command+B (Mac OS) to make another bin.

   **Tip:** If an existing bin is selected when you create a new bin, it will be created inside the selected bin. Deselect first to avoid this, or drag the new bin out of the selected bin once it appears.

10. Name the bin *Sequences*.

   **Note:** To rename a bin, select it and press Enter (not the carriage return), or click away from the text.

If your Project panel is set to List view, bins are displayed in alphabetical order among the clips.
Managing media in bins

Now that you have some bins, let’s put them to use. As you move clips into bins, use the disclosure triangles to hide their contents and tidy up the view.

1. Drag the clip Brightlove_film_logo.ai into the Illustrator Files bin.
2. Drag Theft_Unexpected.png into the Graphics bin.
3. Drag the Theft_Unexpected_Layered bin (created automatically when you imported the layered PSD file as individual layers) into the Graphics bin.
4. Drag the clip Under Basket.MOV into the City Views bin. You may need to resize the panel or switch it to full-screen to see both the clip and the bin.
5. Drag the sequence called First Sequence into the Sequences bin.
6. Drag all the remaining clips into the Theft Unexpected bin.

You should now have a nicely organized Project panel, with each kind of clip in its own bin.

You can also copy and paste clips to make extra copies if this helps you stay organized. In the Graphics bin, you have a PNG file that might be useful for the Theft Unexpected content. Let’s make an extra copy.

7. Click the disclosure triangle for the Graphics bin to display the contents.
8. Right-click the Theft_Unexpected.png clip and choose Copy.
9. Click the disclosure triangle for the Theft Unexpected bin to display the contents.
10. Right-click the Theft Unexpected bin, and choose Paste.

Premiere Pro places a copy of the clip in the Theft Unexpected bin.

*Note:* When you make copies of clips, you are not making copies of the media files they are linked to. You can make as many copies as you like of a clip in your Premiere Pro project. Those copies will all link to the same original media file.

Finding your media files

If you’re not sure where a media file is on your hard drive, right-click the clip in the Project panel and choose Reveal in Explorer (Windows) or Reveal in Finder (Mac OS).

Premiere Pro will open the folder in your storage drive that contains the media file and highlight it. This can be useful if you are working with media files stored on multiple hard drives or if you have renamed your clips in Premiere Pro.

*Tip:* You can make Shift-click and Control-click (Windows) or Command-click (Mac OS) selections in the Project panel, just as you can with files on your hard drive.
Changing bin views

Although there is a distinction between the Project panel and bins, they have the same controls and viewing options. For all intents and purposes, you can treat the Project panel as a bin; many Premiere Pro editors use the terms bin and Project panel interchangeably.

Bins have two views. You choose between them by clicking the List View button or Icon View button at the bottom left of the Project panel.

- **List view**: This view displays your clips and bins as a list, with a significant amount of metadata displayed. You can scroll through the metadata and use it to sort clips by clicking column headers.

- **Icon view**: This view displays your clips and bins as thumbnails you can rearrange and play back.

The Project panel has a zoom control, next to the List View and Icon View buttons, which changes the size of the clip icons or thumbnails.

1. Double-click the Unexpected bin to open it in its own floating panel.
2. Click the Icon View button on the Unexpected bin to display thumbnails for the clips.
3. Try adjusting the zoom control.
   
   Premiere Pro can display large thumbnails to make browsing and selecting your clips easier.

   You can also apply various kinds of sorting to clip thumbnails in Icon view by clicking the Sort Icons menu.

4. Switch to List view.
5. Try adjusting the Zoom control for the bin.
   
   When you’re in List view, it doesn’t help that much to zoom, unless you turn on the display of thumbnails in this view.

6. Click the panel menu (next to the name on the panel tab), and choose Thumbnails.
   
   Premiere Pro now displays thumbnails in List view, as well as in Icon view.

**Note**: You can also change the font size in the Project panel by clicking the panel menu and choosing Font Size. This is particularly useful if you are working on a high-resolution screen.
Try adjusting the Zoom control.

The clip thumbnails show the first frame of the media. In some clips, the first frame will not be particularly useful. Look at the clip HS Suit, for example. The thumbnail shows the clapperboard, but it would be useful to see the character.

Switch to Icon view.

In this view, you can hover the mouse cursor over clip thumbnails to preview clips.

Hover the mouse cursor over the HS Suit clip. Move the mouse until you find a frame that better represents the shot.

While the frame you have chosen is displayed, press the I key.

I is the keyboard shortcut for Mark In, a command that sets the beginning of a selection when choosing part of a clip that you intend to add to a sequence. The same selection also sets the poster frame for a clip in a bin.

Switch to List view.

Premiere Pro shows your newly selected frame as the thumbnail for this clip.

Use the panel menu (on the panel tab) to turn off thumbnails in List view.

Close the Theft Unexpected bin.
Creating Search bins

When using the Filter Bin Content box to display specific clips, you have the option to create a special kind of virtual bin, called a Search bin.

After typing in the Filter Bin Content box, click the Create New Search Bin button ( ).

Search bins appear in the Project panel automatically. They display the results of a search performed when using the Filter Bin Content box.

The contents of a Search bin will update dynamically, so if you add new clips to a project that meet the search criteria, they’ll appear in the search bin automatically. This can be a fantastic time-saver when working with documentary material that changes over time as you obtain new footage.

Tip: When you’ve finished using the Filter Bin Content box, be sure to click the X on the right side to clear the filter.

Assigning labels

Every item in the Project panel has a label color. In List view, the Label column shows the label color for every clip. When you add clips to a sequence, they are displayed in the Timeline panel with this label color.

Let’s change the label color for a title.

1 Right-click Theft_Unexpected.png and choose Label > Forest.

2 Press Control+Z (Windows) or Command+Z (Mac OS) to change the Theft_Unexpected.png label color back to Lavender.

When you add a clip to a sequence, Premiere Pro creates a new instance, or copy of that clip. You’ll have one copy in the Project panel and one copy in the sequence.

By default, when you change the label color for a clip in the Project panel or rename a clip, it won’t update copies of the clip in sequences.

You can change this by choosing File > Project Settings > General and enabling the option to display the project item name and label color for all instances.
Changing the available label colors

You can assign up to eight colors as labels to items in your project. There are also eight types of items that label colors can be assigned to, which means there aren’t any spare label colors.

If you choose Edit > Preferences > Label Colors (Windows) or Premiere Pro > Preferences > Label Colors (Mac OS), you’ll see the list of colors, each with a color swatch. You can click the color swatch to change the color.

If you select Label Defaults in the preferences, you can choose different default labels for each kind of item in your project.

Changing names

Because clips in your project are separate from the media files they link to, you can rename items in Premiere Pro, and the names of your original media files on the hard drive are left untouched. This makes renaming clips safe to do—and it can be helpful when organizing a complex project.

1. Open the Graphics bin.
2. Right-click the clip Theft_Unexpected.png and choose Rename.
3. Change the name to TU Title BW.
4. Right-click the newly renamed clip, TU Title BW, and choose Reveal in Explorer (Windows) or Reveal in Finder (Mac OS).

The file is displayed. Notice that the original filename has not changed. It’s helpful to be clear about the relationship between your original media files and the clips inside Premiere Pro because it explains much of the way the application works.

Customizing bins

When set to List view, the Project panel displays a number of clip information headings. You can easily add or remove headings. Depending on the clips you have and the types of metadata you are working with, you might want to display or hide some headings.
1. Double-click to open the Theft Unexpected bin.

2. Click the panel menu, and choose Metadata Display.

   ![Metadata Display panel](image)

   The Metadata Display panel allows you to choose any kind of metadata to use as a heading in the List view of the Project panel (and any bins). All you have to do is select the check box for the kind of information you would like to be included.

3. Click the disclosure triangle for Premiere Pro Project Metadata to show those options.

4. Select the Media Type check box.

5. Click OK.

   ![Metadata table](image)

   Media Type is now added as a heading for the Theft Unexpected bin only. You can apply the change to every bin in one step by using the panel menu in the Project panel, rather than in an individual bin.

   Some headings are for information only, while others can be edited directly in the bin. The Scene heading, for example, allows you to add a scene number for each clip, while the Media Type heading gives information about the media and cannot be edited directly.

   If you add information and press the Enter/Return key, Premiere Pro activates the same box for the next clip down. This way, you can use the keyboard to quickly enter information about several clips, jumping from one box to the next without using your mouse.

   **Note:** Several useful bin headings are displayed by default, including the Good check box. Select this box for clips you prefer, and then click the heading to sort selects from unwanted content.
Having multiple bins open at once

Every bin panel behaves in the same way, with the same options, buttons, and settings. By default, when you double-click a bin, it opens in a floating panel. You can change this in Preferences.

To change the options, choose Edit > Preferences > General (Windows) or Premiere Pro > Preferences > General (Mac OS).

The options allow you to choose what will happen when you double-click, double-click with the Control (Windows) or Command (Mac OS) key, or double-click with the Alt (Windows) or Option (Mac OS) key.

Monitoring footage

The greater part of video editing is spent watching clips and making creative choices about them. It’s important to feel comfortable browsing media because you’ll be doing a lot of it!

Premiere Pro has multiple ways to perform common tasks, such as playing video clips. You can use the keyboard, click buttons with your mouse, or use an external device like a jog/shuttle controller.

1. Double-click the Theft Unexpected bin to open it.
2. Click the Icon View button at the lower-left corner of the bin.
3. Hover your mouse (drag without clicking) across any of the images in the bin.

Premiere Pro displays the contents of the clip as you drag. The left edge of the thumbnail represents the beginning of the clip, and the right edge represents the end. In this way, the width of the thumbnail represents the whole clip.
4 Select a clip by clicking it once (be careful not to double-click, or the clip will open in the Source Monitor). Hover scrubbing is now turned off, and a mini playhead appears at the bottom of the thumbnail. Try dragging through the clip using the playhead.

When a clip is selected, you can use the J, K, and L keys on your keyboard to perform playback, just as you can in the Media Browser.

- **J**: Play backward
- **K**: Pause
- **L**: Play forward

5 Select a clip, and use the J, K, and L keys to play the video in the thumbnail.
When you double-click a clip, not only does Premiere Pro display the clip in the Source Monitor, but it adds it to a list of recent clips.

6 Double-click to open four or five clips from the Theft Unexpected bin in the Source Monitor.

7 Click the panel menu on the tab at the top of the Source Monitor to browse between your recent clips.

**Tip:** If you press the J or L key multiple times, Premiere Pro will play the video clips at multiple speeds.

**Tip:** Notice that you have the option to close a single clip or close all clips, clearing the menu and the monitor. Some editors like to clear the menu and then open several clips that are part of a scene by selecting them in the bin and dragging them into the Source Monitor together. You can then use the Recent Items menu to browse only the clips from that selection.
8 Click the Zoom menu at the bottom of the Source Monitor.

By default, this is set to Fit, which means Premiere Pro will display the whole frame, regardless of the original size. Change the setting to 100%.

These clips are high-resolution, and they are probably much bigger than your Source Monitor.

It’s likely scroll bars have appeared at the bottom and on the right of your Source Monitor so you can view different parts of the image.

The benefit of viewing with Zoom set to 100% is that you see every pixel of the original video, which is useful for checking the quality.

9 Set the Zoom menu back to Fit.

**Lowering the playback resolution**

If you have an older or slower computer processor or are working with RAW media with large frame sizes, such as Ultra High-Definition (4K or above), your computer may struggle to play back all the frames of your video clips. Clips will play with the correct timing (so 10 seconds of video will still take 10 seconds), but some frames may not be displayed.

To work with a wide variety of computer hardware configurations, from powerful desktop workstations to lightweight portable laptops, Premiere Pro can lower the playback resolution to make playback smoother.

The default resolution is 1/2. You can switch the playback resolution as often as you like, using the Select Playback Resolution menu on the Source Monitor and Program Monitor panels.

Some lower resolutions are available only when working with particular media types.
Getting timecode information

At the bottom left of the Source Monitor, a timecode display shows the current position of the playhead in hours, minutes, seconds, and frames (00:00:00:00).

For example, 00:15:10:01 is 0 hours, 15 minutes, 10 seconds, and 1 frame.

Note that this is based on the original timecode for the clip, which probably does not begin at 00:00:00:00.

At the bottom right of the Source Monitor, a timecode display shows the duration of your clip. By default, this shows the whole clip duration, but later you’ll add special marks to make a partial selection. When you do, that duration shown will change accordingly.

Displaying safe margins

Television monitors often crop the edges of the picture to achieve a clean edge. If you’re producing video for a cathode ray tube (CRT) monitor, quite a lot of the image can be cropped. Click the Settings menu ( ) at the bottom of the Source Monitor and choose Safe Margins to display useful white outlines over the image.

The outer box is the action-safe zone. Aim to keep important action inside this box so that when the picture is displayed, edge cropping does not hide what’s going on.

The inner box is the title-safe zone. Keep titles and graphics inside this box so that even on a badly adjusted display, your audience will be able to read the words.

Premiere Pro also has advanced overlay options that can be configured to display useful information in the Source Monitor and Program Monitor. To enable or disable overlays, go to the monitor Settings menu ( ) and choose Overlays.
You can access the specific settings for overlays and safe margins by clicking the monitor Settings menu and choosing Overlay Settings > Settings.

Click the Settings button at the bottom of the Source Monitor, and choose Safe Margins to hide them.

**Using essential playback controls**

Let’s look at the playback controls.

1. Double-click the shot Excuse Me in the Theft Unexpected bin to open it in the Source Monitor.

2. At the bottom of the Source Monitor, you’ll find a blue playhead marker. Drag it along the bottom of the panel to view different parts of the clip. You can also click wherever you want the playhead to go, and it will jump to that spot.

3. Below the time ruler and the playhead, there’s a scroll bar that doubles as a Zoom control. Drag one end of the scroll bar to zoom in on the clip navigator.

4. Click the Play/Stop button to play the clip. Click it again to stop playback. You can also use the spacebar to play and stop playback.

5. Click the Step Back 1 Frame and Step Forward 1 Frame buttons to move through the clip one frame at a time. You can also use the Left Arrow and Right Arrow keys on your keyboard.

6. Try using the J, K, and L keys to play your clip.

**Note:** Selection is important when using keyboard shortcuts. If you find the J, K, and L keys don’t work, double-check the Source Monitor is selected, with a blue outline.
Customizing the monitors

To customize the way a monitor displays video, click the Settings menu ( ).

The Source Monitor and Program Monitor have similar options. You can view an audio waveform, which shows amplitude over time, and if your video has fields, you can choose which fields are shown.

Make sure Composite Video is selected in the Settings menu for now.

You can also switch between viewing the clip audio waveform and the video by clicking the Drag Video Only ( ) or Drag Audio Only ( ) icon. These icons are mainly used when editing clips into a sequence by dragging with the mouse but also provide this useful display shortcut.

You can change the buttons displayed at the bottom of the Source Monitor and Program Monitor.

1. Click the Button Editor ( ) at the bottom right of the Source Monitor.

   A special set of buttons appears on a floating panel.

   ![Button Editor](image)

2. Drag the Loop button ( ) from the floating panel to a spot to the right of the Play button on the Source Monitor, and click OK.

3. Double-click the Excuse Me clip in the Theft Unexpected bin to open it in the Source Monitor if it isn’t open already.

4. Click the new Loop button to enable it.

5. Click the Play button to play the clip. Play the video using the spacebar or the Play button on the Source Monitor. Stop the playback when you’ve seen the video start again.

   With Loop turned on, Premiere Pro continuously repeats playback of a clip or sequence.

6. Click the Step Back 1 Frame and Step Forward 1 Frame buttons to move through the clip one frame at a time. You can also use the Left Arrow and Right Arrow keys on your keyboard.
Modifying clips

Premiere Pro uses metadata associated with clips to know how to play them back. This metadata is normally added correctly by the camera, but occasionally it might be wrong. You'll need to tell Premiere Pro how to interpret a clip.

You can change the interpretation of clips for one file or multiple files in a single step. All clips you have selected are affected by changes to interpretation.

Adjusting audio channels

Premiere Pro has advanced audio management features. You can create complex sound mixes and selectively target output audio channels with original clip audio. You can produce mono, stereo, 5.1, and even 32-channel sequences with precise control over the routing of audio channels.

If you're just starting out, you'll probably want to produce sequences mastered in stereo using mono or stereo source clips. In this case, the default settings are most likely what you need.

When recording audio with a professional camera, it's common to have one microphone record onto one audio channel and a different microphone record onto another audio channel. These are the same audio channels that would be used for regular stereo audio, but they now contain completely separate sound.

Your camera adds metadata to the audio to tell Premiere Pro whether the sound is meant to be mono (separate audio channels) or stereo (channel 1 audio and channel 2 audio combined to produce the complete stereo mix).

You can tell Premiere Pro how to interpret audio channels when new media files are imported by choosing Edit > Preferences > Audio > Default Audio Tracks (Windows) or Premiere Pro > Preferences > Audio > Default Audio Tracks (Mac OS).

If the setting was wrong when you imported your clips, it's easy to set a different way to interpret the audio channels in the Project panel.

1 Right-click the Reveal clip in the Theft Unexpected bin, and choose Modify > Audio Channels.
When the Preset menu is set to Use File, as it is here, Premiere Pro will use the file's metadata to set the channel format for the audio.

In this case, Clip Channel Format is set to stereo, and Number of Audio Clips is set to 1—that's the number of audio clips that will be added to a sequence if you edit this clip into it.

Now look at the channel matrix below those options:

The Left and Right audio channels of the source clip (described as Media Source Channel) are both assigned to a single clip (described as Clip 1).

When you add this clip to a sequence, it will appear as one video clip and one audio clip, with both audio channels in the same audio clip.

2 Click the Preset menu and change it to Mono.

Premiere Pro switches the Channel Format menu to Mono, so the Left and Right source channels are now linked to two separate clips.

This means that when you add the clip to a sequence, each audio channel will go on a separate track, as separate clips, allowing you to work on them independently.

3 Click OK.

**Merging clips**

It's common for video to be recorded on a camera with relatively low-quality audio, while high-quality sound is recorded on a separate device. When working this way, you'll want to combine the high-quality audio with the video by merging them in the Project panel.

The most important factor when merging video and audio files in this way is synchronization. You will either manually define a sync point—like a clapperboard mark—or allow Premiere Pro to sync your clips automatically based on their original timecode information or by matching up their audio.
A few tips on audio clip channel interpretation

Here are some things to keep in mind when working with audio clip channel interpretation:

• In the Modify Clip dialog box, every available audio channel will be listed. If your source audio has channels you don’t need, you can deselect them.
• You can override the original file audio channel interpretation. This will mean a different type of audio track may be needed in a sequence.
• The list of clips on the left (which may be as short as one clip) shows how many audio clips will be added to a sequence when edited in.
• Use the check boxes to choose which source audio channels are included in each sequence audio clip. This means you can easily combine multiple source audio channels into a single sequence clip or separate them into different clips in any way that works for your project.

If you choose to sync clips using audio, Premiere Pro will analyze both the in-camera audio and the separately captured sound and match them up.

• If you don’t have matching audio in the clips you are merging, you can manually add a marker. If you’re adding a mark, place it on a clear sync point like a clapperboard.
• Select the camera clip and the separate audio clip, right-click either item, and choose Merge Clips.
• Under Synchronize Point, choose your sync point, and click OK.

A new clip is created that combines the video and the “good” audio in a single item.

Interpreting video footage

For Premiere Pro to play a clip correctly, it needs to know the frame rate for the video, the pixel aspect ratio (the shape of the pixels), and, if your clip is interlaced, the order in which to display the fields. Premiere Pro can find out this information from the file’s metadata, but you can change the interpretation easily.

1 Import RED Video.R3D from the Lessons/Assets/Video and Audio Files/RED folder. Double-click the clip to open it in the Source Monitor. It’s full anamorphic widescreen, which is too wide for this project.

2 Right-click the clip in the Project panel and choose Modify > Interpret Footage. The option to modify audio channels is unavailable because this clip has no audio.
Right now, the clip is set to use the pixel aspect ratio setting from the file: Anamorphic 2:1. This means the pixels are twice as wide as they are tall.

Use the Conform To menu to change the Pixel Aspect Ratio setting to DVCPRO HD (1.5). Then click OK.

From now on, Premiere Pro will interpret the clip as having pixels that are 1.5 times wider than they are tall. This reshapes the picture to make it standard 16:9 widescreen. You can see the result in the Source Monitor.

This won’t always work—in fact, it often introduces unwanted distortion—but it can provide a quick fix for mismatched media (a common problem for news editors), particularly if the image content is of natural environments without a frame of reference like a person in the shot.

Working with raw files

Premiere Pro has special settings for .R3D files created by RED cameras, .ari files created by ARRI cameras, and several others. These files are similar to the Camera RAW format used by professional digital single-lens reflex (DSLR) still cameras.

RAW files always have a layer of interpretation applied to them in order to view them. You can change the interpretation at any time without impacting playback performance. This means you can make changes, for example, to the colors in a shot without requiring any extra processing power. You could achieve a similar result using a special effect, but your computer would have to do more work to play the clip.

The Effect Controls panel gives access to controls for clips in sequences and in the Project panel. You also can use it to change the interpretation of RAW media files.

1 Double-click the RED Video.R3D clip to open it in the Source Monitor.

2 Using the panel tab, drag the Effect Controls panel over the Program Monitor so you can see both the Source Monitor and the Effect Controls panel at the same time.

Because the RED Video.R3D clip is displayed in the Source Monitor, the Effect Controls panel now shows the RED Source Settings options for that clip, which change the way the RAW media is interpreted.
In many ways, this is a set of color adjustment controls, with automatic white balance and individual adjustments for the red, green, and blue values.

3 Scroll down to the end of the list, where you’ll find Gain settings. Increase the Red gain to about 1.5. You can click the disclosure triangle to reveal a slider control, drag the blue number directly, or click and type over the number.

4 Take another look at the clip in the Source Monitor. The picture has updated. If you had already edited this clip into a sequence, it would update in the sequence too.

For more information about working with RED media, go to http://helpx.adobe.com/premiere-pro/compatibility.html.

Different RAW media files will give different Source Settings options in the Effect Controls panel. There are many other ways to adjust the look of your video clips, and you’ll be looking at some of the options in Lesson 14, “Improving Clips with Color Correction and Grading.”
Review questions

1. How do you change the List view headings displayed in the Project panel?
2. How can you quickly filter the display of clips in the Project panel to make finding a clip easier?
3. How do you create a new bin?
4. If you change the name of a clip in the Project panel, does it change the name of the media file it links to on your hard drive?
5. What keyboard shortcuts can you use to play video and sound clips?
6. How can you change the way clip audio channels are interpreted?
Review answers

1 Click the panel menu for the Project panel, and choose Metadata Display. Select the check box for any heading you want to appear.

2 Click the Filter Bin Content box and start typing the name of the clip you are looking for. Premiere Pro hides clips that don’t match what you typed and reveals those that do.

3 There are several ways to create a new bin: by clicking the New Bin button at the bottom of the Project panel, by choosing File > New > Bin, by right-clicking a blank area in the Project panel and choosing New Bin, or by pressing Control+B (Windows) or Command+B (Mac OS). You can also drag and drop clips onto the New Bin button on the Project panel.

4 No. You can duplicate, rename, or delete clips in your Project panel, and nothing will happen to your original media files.

5 The spacebar plays and stops. J, K, and L can be used like a shuttle controller to play backward and forward, and the arrow keys can be used to move one frame backward or one frame forward.

6 In the Project panel, right-click the clip you want to change and choose Modify > Audio Channels. Choose the correct option (usually by selecting a preset), and click OK.
INDEX

= (equal sign) key, 159
/ (forward slash) key, 111
` (grave) key, 57, 59, 72, 99
3D motion effect, 224–225
5:1 audio tracks, 44, 45
8-bit video, 322–323, 347
32-bit color effects, 291–292
64-bit processing, 29
360 video, 7, 132–133

A
AAC Audio format, 428
AAF files, 37–38, 437
A/B editing mode, 163
Accelerated effect icon, 291
action-safe zone, 86, 384
active panels, 99
adaptive audio tracks, 44
Adaptive Submix option, 45
Add Marker button, 101, 134
additive color, 336, 357
adjustment layers
  applying effects with, 294–296
  creating a color look using, 351–352
Adobe Authorized Training Centers, xxi
Adobe Creative Cloud. See Creative Cloud
Adobe Media Encoder, 7, 9, 55, 422, 427–435
  See also exporting
Adobe Mercury Transmit, 31
Adobe Stock images, 63
advanced Find option, 74–75
After Effects, 8, 9
  applying effects with, 297–299
  importing compositions from, 60, 418
  sending clips to, 296–297
AIFF file format, 428
aligning
  elements in titles, 395–396
  video text, 384
alpha channels
  explanation of, 357–358, 359
  working with, 363–364
AMA system, 38
amplitude, 251
anchor points, 203, 210
angles, multicamera, 238
animation
  of clip size changes, 214–216
  keyframe interpolation and, 216–217
  See also Motion effect
Anti-flicker filter, 203
Appearance preferences, 17
area type, 384, 388
arrow keys, 126
AS-10 and AS-11 formats, 428
audio, 6, 240–285
  characteristics of, 250–251
  cleaning up noisy, 275–282
  display format options, 30–31
  effects for sweetening, 266–275
  EQ adjustments, 271–275
  export settings for, 431
  gain adjustments, 255
  getting started with, 242
  installing plug-ins for, 272
  interface setup, 242–250
loudness measurements, 282–284
master track output, 245–246
monitoring process, 250
multicamera sync using, 232
normalizing, 255–256
recording voice-over, 65–66, 252–253
review questions/answers on, 263, 285
samples and sample rate, 30, 246–247
selecting without video, 143–144
sending to Adobe Audition, 257
speed changes and, 179
split edits, 257–258
submixes, 45
syncing with video, 90–91
track types, 44, 249–250
transitions, 168–170
volume adjustments, 253–256, 258–262
waveforms, 248–249
audio channels
adjusting, 89–90
explanation of, 245
interpretation tips, 91
Audio Clip Mixer, 13, 244, 261–262
audio effects, 264–285
Adobe Audition, 280–282
Bass effect, 267
Delay effect, 268–269
EQ effects, 271–275
Highpass and Lowpass effects, 275–276
Loudness Radar effect, 282–284
MultiBandCompressor effect, 276–278
Notch effect, 279
Pitch Shifter effect, 269–270
review questions/answers on, 285
Studio Reverb effect, 270–271
Treble effect, 270
See also video effects
Audio Gain panel, 255
audio meters, 246, 247
audio noise removal, 275–282
Adobe Audition used for, 280–282
Highpass and Lowpass effects for, 275–276
MultiBandCompressor effect for, 276–278
Notch effect for, 279
Audio Plug-in Manager, 275
Audio Track Mixer, 244
Audio workspace, 243–244
Audition, Adobe, 8, 9, 257, 280–282
Auto Bézier interpolation, 217, 309
Auto Levels feature, 348
Auto Save feature, 17, 32–33
Automate To Sequence option, 119–120, 138
AVI file format, 429
Avid Media Composer, 37–38
B
backups, 17–18
Basic 3D effect, 224–225
bass adjustments, 267
Batch Capture option, 405
bevel effects, 220–222
Bézier curve controls, 202
Bézier interpolation method, 216, 309
bins, 30, 75–83
creating new, 76
customizing, 81–82
filtering content in, 73–74
managing media in, 77
opening multiple, 83
renaming clips in, 81
Search bin creation, 80
view options for, 78–80
See also Project panel
bit depth, 43
Black & White effect, 292–293, 338
blend modes, 360
combining tracks based on, 362–363
tip for scrolling through, 363
video effects and, 295–296
BMP file format, 429
Brightness & Contrast effect, 342–343
broadcast-safe colors, 390
bumpers, 376
Button Editor, 66, 88, 113, 243, 400
C
captions, 398–400, 431
Captions panel, 399
capture format setting, 31
capturing media
  from DV and HDV cameras, 31
  from third-party hardware, 31
  from videotape, 65
centering text, 378
chain icon, 179
Change Clip Speed option, 174
channels
  alpha, 357–358, 359
  audio, 89–90, 91
chapter marker, 134
chromakey effects, 364–369
Classroom in a Book training series, xvii
clip markers, 136–137
Clip Name effect, 313, 314–315
Clip Speed/Duration dialog, 178–179
clipboard, 148
clips
  closing, 84
  conforming, 38–39, 108
  copying, 144
  deleting, 149–150
  disabling, 150
  dragging, 145–146
  finding, 73–75
  handles of, 156–157
  importing, 59
  label colors for, 80–81
  linking and unlinking, 144–145
  loading, 99–100
  locating on drives, 77
  markers added to, 136–137
  masking, 369–371
  master, 299–301
  media files vs., 81, 95
  merging, 90–91
  moving, 145–148
  nudging, 146
  offline, 405–406
  organizing, 70–83
  origin of term, 5, 24
  playback speed of, 84, 174, 176–183
  playing, 84–87
  previewing, 58
  rearranging, 147
  removing, 148–150
  renaming, 81
  replacing, 183–184
repositioning, 207–209
resizing, 211–214
rotating, 210–211
scrubbing, 83
selecting, 101–103, 142–144, 170
splitting, 144
subclips created from, 104–105
volume adjustments, 258–262
closed captions, 398, 399–400
codecs, 41, 409, 410, 426–427
collaboration, 416
collecting files, 408–409
color balance fixes, 344–349
  basic white balance, 345
  Lumetri Color panel for, 348–349
  primary color correction, 346–348
color correction, 6, 322–353
  color grading and, 324
  Color workspace for, 324–325
  creating a look through, 351–352
  effects related to, 337–340, 350–351
  exposure problems and, 341–344
  getting started with, 322
  guidelines for checking, 344
  Lumetri Color panel and, 325–328, 348–349,
    350–351
  Lumetri Scopes panel and, 329, 330–337
  review questions/answers on, 353
  Ultra Key effect and, 369
  white balance and, 344–349
  workflow for, 323–327
color grading, 324
Color Picker, 390
color space, 330
color wheels, 327, 349
Color workspace, 324–325
coloring effects, 338
colors
  additive and subtractive, 336
  broadcast-safe, 390
  primary and secondary, 335
  project label, 80–81
  removing or replacing, 339
  text, 381, 390
comment marker, 134
Commit button, 392
compositing, 354–373
  alpha channels for, 357–358, 363–364
  blend modes used in, 362–363
color keying greenscreen shots for, 364–369
getting started with, 356–357
masking clips for, 369–371
Opacity effect for, 360–363
review questions/answers on, 372–373
shooting videos for, 358–359
terminology related to, 359–360
conforming process, 38–39, 108
consolidating projects, 406, 409–411
Constant Gain crossfade, 168
Constant Power crossfade, 168
Continuous Bézier interpolation, 217, 309
copying/pasting
clip segments, 148
video effects, 294
crawling text, 396
Creative Cloud
expanding the workflow using, 8–9
saving backup files to, 17–18, 33
sharing files using, 416
credits, rolling text for, 396–398
Cross Dissolve effect, 158, 161–162, 166
crossfade transitions, 168
CRT monitors, 86
Curves adjustments, 326
customizing
bins, 81–82
media cache, 64
monitors, 88
Project panel, 71–72
sequence presets, 42
transitions, 163–165
workspaces, 14–16
cuts, 156

D
decibel (dB) scale, 247
Delay effect, 267, 268–269
deleting
clips, 70, 149–150
media files, 406, 411
See also removing
Dip to White transition, 159
Directional Blur effect, 293
disabling clips, 150
distortion removal, 317
DNxHR/DNxHD formats, 428
DPX file format, 428
Drag Audio Only icon, 88, 128–129, 248
Drag Video Only icon, 88, 128–129
dragging clips, 145–146
drop shadows
motion effects and, 219–220
text styles and, 390
drop zone, 16
dropped frames, 26–27
duration
audio transition, 169
displaying clips by, 73
setting for still images, 119
speed changes related to, 178–183
timecode display showing, 86
video transition, 160, 164, 167
DV and HDV camera captures, 31
Dynamic Link, 8, 9, 60, 296, 418
dynamic trimming, 197

E
Ease In/Out controls, 218–219, 307, 309
edit decision lists (EDLs), 438
Edit Original option, 62
edit points, 156
editing
multicamera, 7, 228–239
nonlinear, 4
See also video editing
Editing workspace, 11, 98
edits
extract, 141, 149
four-point, 117, 174–176
insert, 114–116, 127–129
lift, 148–149
overwrite, 113–114, 141
replacing, 184–185
ripple, 189–190
rolling, 191
sliding, 191–192
slip, 192–193
split, 257–258
three-point, 116
Effect Controls panel, 13, 14
  customizing transitions in, 155, 163–165
Input Levels controls, 302–303
interpretation of RAW media files, 92–93
Motion effect controls, 204
Show/Hide Timeline View button, 163
video effect settings in, 292
volume adjustments in, 253–254
effects. See audio effects; video effects
Effects panel, 13, 157, 290–292, 311
End key, 126
EQ controls, 267, 271–275
  Parametric EQ, 272–275
  Simple Parametric EQ, 272
Exponential Fade transition, 168
Export Frame button, 101, 423
Export Settings dialog, 424–425, 430–432
exporting, 420–437
  AAF files, 37–38, 437
  configuration settings for, 430–432
  file formats for, 427–429, 433
  Final Cut Pro files, 36, 436
markers, 134
master copies, 424–427
OMF files, 436–437
overview of options for, 422
queuing media files for, 432–434
review questions/answers on, 440–441
selections as projects, 416
  single frames, 423–424
to social media, 435
titles, 380
  See also Adobe Media Encoder
exposure problems, 341–344
  overexposed images, 343–344
  underexposed images, 342–343
Extract button, 149
electronic, 141, 149
Eyedropper tool, 390

F
Fast Color Corrector effect, 300–301, 302–303, 339, 345
Feet + Frames option, 30
file formats
  choosing for export, 427–429, 433
  supported by Premiere Pro, 56
File menu, 404–406
  making a clip offline in, 405–406
  project management options, 405
File Type menu, 58
file-based camera workflow, 55–56
files, project, 11, 17, 24
  See also media files
fill type, 389
filtering bin content, 73–74
Final Cut Pro
  exporting files from, 36, 436
  importing projects from, 36–37
Final Practice project file, 438–439
Find panel, 75
finding assets
  Effects panel for, 291, 292, 337
  Find panel for, 75
  Media Browser for, 56–59
  Project panel for, 73–75
  Timeline panel for, 139
FireWire connections, 31
Fit Clip dialog, 174–175
Fit to Fill edit, 176
fixed effects, 202, 288–290, 294
Flash cue points, 134
flattened files
  creating from multicamera edits, 238
  importing from Photoshop, 60
Flip Over transition, 159
Font Browser menu, 377
fonts
  browsing in Titler, 377–378
  factors for choosing, 380
  resizing in Project panel, 16, 78
  See also text
footage, replacing, 185–186
forums, Adobe, xxi
four-point editing, 117, 174–176
  options available for, 174–175
  steps in process of, 175–176
frames
  dropped, 26–27
  exporting single, 423–424
  video displayed in, 30
frames per second (fps), 30
freeze frame, 166, 167
frequency, audio, 250–251
fx button, 292, 307
G

gain adjustments, 255

Gaps, finding, 141–142
garbage matte, 370
Gaussian Blur effect, 295, 350
GIF file formats, 429

Go to In/Out buttons, 101

GoPro CineForm codec, 410, 426, 427
GPU acceleration, 7, 291
GPU cards, 291, 311

graphics
adding to titles, 395
Photoshop for creating, 391–392

gray interface, 328
grayscale, 292, 357
greenscreen, 360
color keying shots made with, 364–369
shooting videos using, 359

grid
multicamera, 234
transparency, 358

H

H.264 file formats, 428, 433

handles
including in trimmed projects, 407, 411
transition effects and, 156–157, 166–168

hard drives
managing, 417–418
setting up, 34

hardware support, 6

HDR technology, 330

headers, track, 109, 112–113

Help resources, xxi, 25

HEVC/H.265 format, 427

high-bit-depth effects, 291–292
Highpass effect, 275–276

History panel, 14

HLS vectorscope, 334

Hold interpolation method, 217, 309

house (or mezzanine) codec, 409

HSL secondary adjustment, 327

I

Icon View button, 59, 78, 118

Ignore Alpha Channel option, 364

Illustrator, Adobe, 8, 62–63

image stabilization effect, 312–313

images
adding to titles, 395
importing, 59–63

importing, 48–67
Avid Media Composer projects, 37–38
color keying shots made with, 364–369
drives, 359

getting started with, 50
Illustrator files, 62–63
images into projects, 59–63

In and Out marks
Project panel, 104
Source Monitor, 99, 102, 110

three-point editing with, 116
Timeline panel, 111–112

Info panel, 14

ingest settings, 34–35, 54
Input Levels slider, 347

Insert button, 101

insert edits, 114–116, 127–129
installing Premiere Pro, xviii

interactive markers, 137


Interpret Footage option, 91–92, 98, 177

intrinsic effects, 202, 288–290

Invert Alpha Channel option, 364
INDEX

J
J-cut edits, 258
JPEG file formats, 428
jump cuts, 156

K
kerning text, 381–382
Key Color eyedropper, 366–367
keyboard shortcuts, 18–19
  for nudging clips, 146
  for playing clips, 84, 87
  for trimming clips, 198
  for volume adjustments, 260
  for zooming in/out, 106, 109, 159
keyframes, 6, 202
  adding to clips, 305–306
  clip- vs. track-based, 261
  Opacity effect using, 361–362
  time remapping using, 180–183
  Velocity graph for, 306, 308
  video effects using, 304–308
  volume changes using, 260–261
keying process, 356, 360

L
label colors, 80–81
layered Photoshop files, 60–61, 77
L-cut edits, 258
leading, text, 383–384
Lens Distortion effect, 317
Lens Flare effect, 305, 306–308
lesson files, xix–xx, 438–439
letterboxing, 213
levels controls, 347
Libraries panel, 13, 417
lift edits, 148–149
Linear interpolation, 216, 309
Link Media dialog, 405, 412–413
linking clips, 144–145
List View button, 59, 72, 78
loading clips, 99–100
Locate File panel, 413
locking tracks, 140–141
logos in titles, 395
Loop button, 88
Loop Play button, 268
looping playback, 197
Loudness Radar effect, 282–284
lower-thirds, 376
Lowpass effect, 275–276
Lumetri Color panel, 325–328
  built-in looks, 350–351
  color balance adjustments, 348–349
  example of using, 327–328
  sections and controls, 325–327
Lumetri Scopes panel, 329, 330–337
  RGB parade, 336–337
  waveform display, 331–333
  YUV vectorscope, 333–336
Maintain Audio Pitch option, 179
Make Offline option, 405, 406
managing projects. See project management
margins, safe, 86–87, 384
Mark In/Out buttons, 101
Marker dialog, 135
Marker menu, 136
markers, 133–139
  automating to, 137–138
  clip, 136–137
  explanation of, 133–134
  exporting, 134
  interactive, 137
  methods for adding, 134, 136
  multicamera syncing with, 232
  navigating with, 137
  Prelude for adding, 139
  sequence, 134–136
  types of, 134–137
Markers panel, 135, 136, 137
masking
  composited clips, 369–371
  visual effects, 301–304
master clip effects, 299–301
master copy exports, 424–427
  choosing other codecs for, 426–427
  matching sequence settings for, 424–426
Match Frame option, 299
Match Sequence Settings option, 425, 426
Match Source option, 426
mattes, 360
  creating custom, 369–370
  graphics or clips as basis for, 370–371
  Ultra Key effect, 366–368
Maximum Bit Depth option, 43
Maximum Render Quality option, 43
Media Browser, 13, 51–52
  benefits of using, 52
  finding assets with, 56–59
  importing assets with, 415
  maximizing the size of, 57
  navigation features, 59
media cache, 64, 417–418
Media Encoder. See Adobe Media Encoder
media files
  clips vs., 81, 95
  deleting, 406, 411
  info about lesson, xix–xx, 438–439
  locating on drives, 77
  managing, 406–414, 417
  offline, 405–406
  proxy, 52, 54–55
  RAW, 92–93
  renaming, 408
Mercury Playback Engine, 28, 29, 31, 129
merging clips, 90–91
metadata, 7
mezzanine codec, 409
Milliseconds mode, 30
Monitor panels. See Program Monitor; Source Monitor
monitoring footage, 83–88
monitors, using multiple, 100
mono audio tracks, 44
Mono Submix option, 45
Morph Cut transition effect, 165–166
Motion effect, 200–227, 289
  adjusting, 202–207
  clip size changes, 211–216
  Ease In/Out controls, 218–219
  getting started with, 202
  keyframe interpolation and, 216–219
  options for working with, 203
  position changes, 207–209
  properties related to, 205–207
reusing settings for, 209–210
review questions/answers on, 226–227
rotating clips with, 210–211
Transform effect vs., 222–224
motion-related effects
  Basic 3D effect, 224–225
  Bevel effects, 220–222
  Drop Shadow effect, 219–220
moving clips, 145–148
  clipboard and, 148
  dragging and, 145–146
  nudging and, 146
  rearranging and, 147
MP3 file format, 428
MPEG2 file formats, 428–429, 433
MPEG4 file format, 429
MultiBandCompressor effect, 276–278
Multicam Media bin, 232–233
multicamera editing, 7, 228–239
  flattening process, 238
  getting started with, 230
  potential uses for, 231
  re-recording edits in, 237
  review questions/answers on, 239
  sequence creation in, 231–235
  steps in process of, 235–237
  switching angles in, 238
  sync points for, 231–232
  workflow process, 230
multiplexer controls, 431
multithreading, 29
music tracks. See audio
Mute button, 250
MXF OP1a format, 429
New Item menu, 39
New Photoshop File dialog, 391
New Project dialog, 26, 28
New Sequence dialog, 39–40
New Title dialog, 385
noise removal. See audio noise removal
nonlinear editing system (NLE), 4
Normal blend mode, 362, 363
normalizing audio, 255–256
Notch effect, 279
nudging clips, 146

O
Obsolete effects, 290
offline clips, 405–406
OMF file export, 436–437
online clips, 405
opacity, 357, 360
Opacity effect, 289, 360–363
open captions, 398, 400
optimizing performance, xviii
organizing media, 68–83
bins used for, 75–83
Project panel for, 70–75
review questions/answers on, 94–95
See also project management
Out marks. See In and Out marks
Output Levels slider, 347
over-cranking technique, 177
overexposed images, 343–344
overlay options, 86–87
Overwrite button, 101
overwrite edits, 113–114, 141

P
P2 Movie format, 429
panel tab, 17
panels
active, 99
monitor, 13
stacked, 154
See also specific panels
paragraph text, 385, 388–389
Parametric EQ effect, 272–275
path-based text, 385, 394
Paused Resolution setting, 131
Pen tool, 260, 394
performance
optimizing, xviii
playback, 29
phase, audio, 251
photo montage transitions, 161–162
Photoshop, 8, 9
creating titles or graphics in, 391–392
importing files from, 60–62, 77
Pitch Shifter effect, 269–270
pixel aspect ratio, 92
playback
controls for, 87
customizing monitors for, 88
lowering the resolution of, 85
Mercury Playback Engine and, 28, 29
methods for performing, 83–85
real-time, 26–28
rendered, 27, 28
resolution for, 85, 129–131
safe margins display, 86–87
speed controls for, 84, 174, 176–183
trim mode looping, 197
VR video, 132–133
playhead marker, 87
plug-ins, audio, 275
PNG file format, 429
point text, 384, 385–387
Polygon Mask button, 369
Position control, 203, 207–209
preferences, 16–18, 19
Prelude, Adobe, 9
adding markers with, 139
importing files from, 53
Premiere Pro CC
installing, xviii
nonlinear editing, 4
online resources, xxi
performance optimization, xviii
supported file formats, 56
system requirements, xvii
presets
built-in, 309–310
saving, 310–311
sequence, 24, 39–42
video effect, 294, 308–311
previews
   Media Browser, 58
   Project panel, 72
primary color correction, 346–348
primary vs. secondary colors, 335
Program Monitor, 13, 124–129
   adding clips to Timeline with, 126–129
   customizing display of, 88
   features illustration, 125
   insert editing with, 127–129
   navigation bar, 112
   Source Monitor vs., 125
   trimming in, 193–196
   viewing clips in, 305
   See also Source Monitor
project files, 11, 17, 24
project management, 7, 402–419
   collaboration and, 416
   Dynamic Link and, 418
   File menu for, 404–406
   getting started with, 404
   hard drives and, 417–418
   importing projects or sequences, 414–415
   Libraries panel used in, 417
   Project Manager features, 406–413
   Remove Unused option, 414
   review questions/answers on, 419
   See also organizing media
Project Manager, 405, 406–413
   consolidation and transcoding in, 409–411
   file collection and copying in, 408–409
   Link Media dialog, 412–413
   Locate File panel, 413
   options overview, 407–408
   rendering and replacing in, 411–412
   trimmed project creation, 409–411
Project panel, 13, 70–75
   customizing, 71–72
   editing video from, 104
   features overview, 70–71
   finding assets in, 73–75
   font size changes, 16, 78
   label colors in, 80–81
   renaming clips in, 81
   toggling views of, 72
   viewing clips in, 59
   See also bins
   Project Settings option, 405
   project setup, 22–47
      audio display format, 30–31
      Auto Save location, 32–33
      Avid Media Composer imports, 37–38
      capture format settings, 31
      downloaded file location, 33–34
      Final Cut Pro imports, 36–37
      getting started with, 24
      ingest settings, 34–35
      item name display, 31
      label color display, 31
      playback settings, 26–28
      rendering process, 27, 28
      review questions/answers on, 46–47
      scratch disk setup, 32
      sequence creation, 38–42
      Start screen options, 25
      storage systems, 34
      submixes, 45
      track types, 43–44
      video display format, 29–30
   project-based storage setup, 32, 33
   ProRes media files, 37
   proxy workflow, 52, 54–55, 317, 406
   PSD files, 61
   psychoacoustics, 251
   Push transition effect, 159

Q
   QuickTime format, 429

R
   rasterization process, 62
   Rate Stretch tool, 180
   RAW media files, 92–93
   Razor tool, 144
   real-time playback, 26–28
   rearranging clips, 147
   recording voice-overs, 65–66, 252–253
   Rectangle tool, 393–394
   RED media files, 92–93
   regular trim, 188–189, 193
   relinking offline files, xix–xx
   Remove Unused option, 414
saving
effect presets, 310–311
text styles, 391
titles, 379, 380
Scale controls, 203, 212, 213
scratch audio tracks, 65–66, 252–253
scratch disks, 32
scrubbing, 112
Search bins, 80
secondary color correction, 346, 347
secondary vs. primary colors, 335
segmentation marker, 134
selecting
all clips on a track, 143
audio or video only, 143–144, 162
clips in a sequence, 142–143, 170
parts of clips, 101–103
Replace Edit command, 184–185
Replace Footage feature, 185–186, 412
replacing
color in images, 339
edits, 184–185
footage, 185–186
rendering and, 317–318, 411–412
Reset button, 205
renaming. See naming/renaming
rendering, 27, 28
all sequences, 317
maximum quality option for, 43, 434
parts of sequences, 162
and replacing, 317–318, 411–412
Replace Edit command, 184–185
Replace Footage feature, 185–186, 412
replacing
color in images, 339
edits, 184–185
footage, 185–186
rendering and, 317–318, 411–412
Reset button, 205
resizing. See sizing/resizing
resolution, playback, 85, 129–131
resources, Premiere Pro, xxi
Restore Unrendered option, 412
Restrict Trims to Subclip Boundaries option, 105
reverb effect, 267, 270–271
Reverse Speed option, 179, 180
RGB color system, 322–323
RGB Curves effect, 340, 343, 344
RGB parade, 336–337
Ripple Delete edits, 149
Ripple Edit tool, 166, 167, 168, 189–190
ripple trim, 189–190, 193
roll trim, 191, 193
Roll/Crawl Options button, 397
rolling credits, 396–398
Rolling Edit tool, 164, 167, 168, 191, 258
Rotation control, 203, 210–211
rough cuts, 118
rubber bands, 259, 260, 361
S
safe margins display, 86–87, 384
Save Preset dialog, 311
stacked panels, 154
standard audio tracks, 44, 249–250
Start screen, 10, 25
Stereo Submix option, 45
still images
exporting single frames as, 423–424
setting duration for, 119
stock items, 63
Stopwatch icon, 305
storyboards, 117–120
arranging in the Timeline, 118
automating to a sequence, 119–120
building rough cuts using, 118
strokes, text, 390
Studio Reverb effect, 270–271
styles, text, 377, 386, 389–392
subclips, 104–105
subfolders, 63
submixes, 45
subtractive color, 336
sync locks, 140–141
Sync Settings option, 19
synchronizing
audio and video, 90–91
multicamera media, 231–232
preferences between computers, 19
system requirements, xvii
system-based storage setup, 32, 33

T
tape-based video, 65
Targa format, 429
targeting tracks, 109–110
temporal interpolation, 217, 307
text
alignment of, 384
appearance changes, 389–390
captions as, 398–390
colors for, 381, 390
fills for, 389
fonts for, 377–378, 380
kerning, 381–382
leading for, 383–384
paragraph, 385, 388–389
point, 385–387
positioning in videos, 387
review questions/answers on, 401
titles, 7, 374–401
  aligning elements in, 395–396
  creating for video, 385–389
  getting started with, 376
  graphics added to, 395
  overview of features for, 376–379
  Photoshop graphics and, 391–392
  review questions/answers on, 401
  rolling and crawling text for, 396–398
  safe title margins for, 384
  saving as separate files, 380
  shapes created for, 393–395
  stylizing text for, 389–392
  typography essentials for, 380–384
  using in multiple projects, 380
See also text
title-safe zone, 86, 384
Toggle animation button, 205
Toggle Effect button, 369
Toggle Proxies button, 55
Toggle Track Output option, 61
Tonal Range Definition controls, 347
Tools panel, 14
track headers
  customizing, 66, 112–113
  function of, 109
track locks, 141
Track Matte Key effect, 371
Track Meter button, 244
Track Select Backward tool, 143
Track Select Forward tool, 143
tracking
  motion, 301, 304
text, 379, 382–383
tracks, 13
  audio, 44, 249–250
  blend modes combining, 362–363
  explained, 108–109
  headers for, 109, 112–113
  height changes for, 181
  locking, 140–141
  selecting all clips on, 143
  targeting, 109–110
types of, 43–44
transcoding process, 35, 409–411
Transform effect, 222–224
Transform icon, 205

transitions, 152–171
  A/B mode and, 163
  audio, 168–170
  best practices with, 156
  customizing, 163–165
  dragging on Timeline, 166
  duration of, 160, 164, 167
  explanation of, 155
  getting started with, 154
  handles and, 157, 166–168
  Morph Cut effect, 165–166
  multiple-clip, 161–162
  review questions/answers on, 171
  single-sided, 158
  swapping, 160
  two-clip, 159–161
  video, 157–162
  when to use, 155–156
  transparency, 357–358, 363–364
  treble adjustments, 267, 270
  Trim In/Out tools, 189
  trimmed projects, 409–411
  trimming, 7, 164, 188–198
    keyboard shortcuts for, 198
    modifier keys to refine, 196
    performing dynamic, 197
    Program Monitor options for, 193–196
    ripple edits for, 189–190
    rolling edits for, 191
    sequences on the Timeline, 188–189
    sliding edits for, 191–192
    slip edits for, 192–193
    Source Monitor options for, 188
  Type tool, 386, 397
  Typekit fonts, 378
  typography. See text

V

vector graphics, 62, 395
vectorscope, 333–336
Velocity graph, 306, 308

video
  360-degree and VR, 7, 132–133
  display format options, 29–30
  export settings for, 431
  interpreting footage from, 91–92
  RAW files used for, 92–93
  selecting without audio, 143–144
  syncing audio with, 90–91

video editing
  advanced techniques of, 172–199
  delete edits in, 149
  extract edits in, 149
  four-point, 174–176
  getting started with, 98
  insert edits in, 114–116, 127–129
  lift edits in, 148–149
  loading clips for, 99–100
  nesting sequences, 186–187
  overwrite edits in, 113–114
  Program Monitor for, 124–129
  Project panel for, 104
  replacing clips/footage, 183–186
  review questions/answers on, 171
  ripple delete edits in, 149
  second monitor used in, 100
  selecting parts of clips for, 101–103
  sequences used in, 107–108
  Source Monitor for, 98–105
  speed/duration changes, 176–183
  storyboards for, 117–120
  subclip creation in, 104–105
  three-point, 116
  Timeline panel for, 105–113
  tracks used in, 108–110
  transitions used in, 152–171
  trimming as, 188–198

video effects, 286–319
  adjustment layers for, 294–296
  After Effects used for, 296–299
  applying to clips, 292–294
  Clip Name effect, 313, 314–315
  color-related, 337–340, 350–351
  copying/pasting, 294

U

Ultra Key effect, 366–369
underexposed images, 342–343
Undo command, 119, 141
Undock Panel option, 52
unlinking clips, 144–145
Effects panel, 290–292
exporting media with, 431
finding, 291, 292, 337
fixed, 202, 288–290, 294
frequently used, 312–317
getting started with, 288
keyframing, 293, 304–308
Lens Distortion effect, 317
masking and tracking, 301–304
master clip, 299–301
presets for, 294, 308–311
real-time playback of, 26–28
review questions/answers on, 319
Shadow/Highlight effect, 315–316
Timecode effect, 313–314, 315
Warp Stabilizer effect, 312–313
See also audio effects
Video Limiter effect, 340
video scopes, 328
video transitions, 157–162
vignette effect, 327
voice-overs
  recording, 65–66, 252–253
See also audio
volume adjustments, 253–256, 258–262
  Audio Clip Mixer, 261–262
  Effects Control panel, 253–254
gain adjustments, 255
keyboard shortcuts for, 260
keyframes for making, 260–261
normalizing audio, 255–256
overall clip levels, 259
VR video
  360 degree video vs., 132
display mode for, 7
  playing back, 132–133

W
Warp Stabilizer effect, 312–313
Waveform Audio format, 429
waveform display, 331–333
web link marker, 134
web resources, xxi
white balance, 344–349
  basic correction of, 345
  Lumetri color wheels and, 348–349
  primary color correction and, 346–348
White Balance eyedropper, 345
Windows Media format, 429
Word Wrap option, 386
workflow
  color-oriented, 323–337
  enhancing with Premiere Pro, 6–7
  expanding using Creative Cloud, 8–9
  file-based camera, 55–56
  proxy files used in, 52, 54–55
  standard digital video, 5–6
workspaces, 10–18
  Audio workspace, 243–244
  Color workspace, 324–325
  customizing, 14–16
  Editing workspace, 11, 98
  features illustration, 12
  preferences for, 16–18
  principal elements in, 11–14
Workspaces panel, 57
wrapping text, 386
Wraptor DCP format, 429
Write Keyframes button, 261

X
XML files, 36

Y
YC waveform, 331, 332
YUV color system, 322–323
YUV effects, 291, 292
YUV vectorscope, 333–336

Z
Zoom controls, 78–79, 85, 87, 106, 159